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1 Overview 
The ColorCalculator software was developed by ams OSRAM to help users design color 

mixing LED lighting solutions. The software has two main modes of operation along with 

several other useful features. The main start-up window is shown in Figure 2. 

The two main modes of operation are: 

1. General photometry: 

The user either selects the intensity of several LEDs or inputs a spectrum and the program 

calculates several photometric quantities. 

2. Design optimization: 

A set of desired photometric values are specified by the user and the program calculates 

the intensity of the LEDs required to obtain the design. 

The photometric quantities are derived from equations given in CIE documents 13.3 and 15.2. 
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2 Installation and program files 
The program is completely self-contained in the ColorCalculator.exe file, no other files or dll’s 

are needed. The executable can be moved to any directory or copied to any computer without 

having to be installed. The program will create several file when run. These files have names 

such as: ColorCalculator.ini, userSpectra.spec, userFilters.fils, userColors.cols, photometry.txt. 

All of the files created by this program are in plain text can be viewed in a standard text editor 

but should not be changed by the user. Other files may be created but with user defined 

names. 

2.1 Windows version 

The downloaded file is a self-extracting zip file. Save it you your hard drive and double-click. 

Select the folder you want to save the program in. Two files will be saved: ColorCalculator.exe 

and ColorCalculator_User_Guide.pdf (a copy of this document). 

The files the program writes are written to the directory where the ColorCalculator.exe is 

located. You may want to put the ColorCalculator.exe in a central location and create Windows 

shortcuts to this exe in other folders. Then you can edit the “Start in:” directory of the shortcut 

so that all files will be written to the directory where the shortcut is located. In the example 

below the shortcut name is “ColorCalculator.exe – Shortcut”. You can put shortcuts in several 

directories and edit each shortcut so the “Start in” is empty this will results in all files being 

saved to the local directory where the shortcut is. 

This is helpful if you are working on several different projects with different design 

requirements. See Windows help for more information on working with shortcuts. 
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Figure 1: ColorCalculator (Shortcut properties) 

 

2.2 Mac OS X version 

The Mac version runs in X Windows (X11). If you double-click the program and you only see a 

terminal window you need to install the X11 libraries. X Windows (X11) can be installed using 

the XQuartz project files (www.xquartz.org). 

The download file is ColorCalculator.dmg.zip, unzip it by double-clicking it. Open the .dmg file 

and save the two files within, ColorCalculator (the executable) and 

ColorCalculator_User_Guide.pdf (a copy of this document). You start the program by double-

clicking the executable in Finder. The program will try and create a directory called 

“%HOME%/ColorCalculator_OSI/” where your user files and the ini files will be kept. If this 

directory cannot be created these files will be stored in your %HOME% directory. 
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3 Main modes of operation 
Not all of the available menu commands will be discussed in details here. Most of them should 

be fairly obvious to the experienced designer or may be best understood by trying them. Also, 

if you let your mouse pointer hover over an input box many of the input boxes have a small 

pop-up help description. 

Figure 2: Main window at start-up 
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3.1 General photometry 

The user selects the LEDs to include in the design (by checking them), enters the dominate 

wavelengths and the intensities. The intensity can be entered as watts or lumens and these 

can be mixed. Once the design is entered the “Calculate” button is clicked and the results are 

displayed in the window and the resultant spectrum is displayed in the table. The spectra from 

the individual LEDs are combined together additively to give the spectrum of the mix. By 

default, the photometry results are also written to a text file called “photometry.txt” in the 

directory where the ColorCalculator.exe is located. 

The user can also enter a spectrum directly into the table. This is done by first selecting the 

“Direct spectrum input” as the “Analysis type” and pasting the spectrum into the table. You can 

enter the spectrum at predefined wavelength intervals or in a free format. The wavelength 

intervals can be selected from the menu item “Inputs->Spectrum from….”. If the “Inputs ->Free 

format spectrum” is used then the program will resample the entered data to the calculation 

points. The free format spectrum is useful when importing data from photometric sphere 

measurements where the data is not measured at regular intervals. 

Figure 3: Wavelength selection from inputs menu 
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Once a design has been entered it can be saved for later use. To save a spectrum first 

perform a calculation then click the menu item “User Spectra->Save as user spectrum”. You 

will be prompted to enter a name and a LPW. Entering the LPW is optional, you may leave this 

blank. All of the user spectra you save are written to a file called “userSpectra.spec” in the 

directory where the ColorCalculator.exe file is located. The “userSpectra.spec” file is in plain 

text and can be viewed in any standard text editor. 

Under the “User Spectra” menu item are several other functions useful in maintaining and 

manipulating your saved spectra. 

The program can read certain file formats directly without the user having to cut-and-paste the 

data by hand. The program can read data files from the SpecWin and SpectraSuite software 

packages and the IES XML standard format. The “SpectraSuite” format will also read-in an asc 

file with two columns of wavelength and intensity. You can encode the drive current and 

forward voltage in the filename and the program will parse these out and calculate the LPW 

and include this information in the photometry.xls file. Example files names are 

“test_led_3.1V_50mA.isd”, “test led 3.1V 50mA.isd” and “test led 50mA 3.1V.isd”. The 

important feature is that you must use “V” to indicate the forward voltage and “mA” to indicate 

the drive current, with no space between the number and the symbol. Both must be 

surrounded by ether underscores or spaces or be at the beginning or end of the file name for 

this feature to work. You can also use “W” for readings from a watt meter. 

Spectra for current LEDs from ams OSRAM can be downloaded from our website at 

apps.osram-os.com/Characteristic 

Figure 4: User spectra menu 
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You can also read in several spectra at the same time. Enter them in Microsoft Excel then cut 

and paste them in a text file using something like Notepad, see Figure 5. If this file has text in 

the first row it will be used as the names of the spectra when they are saved. This file is tab 

delimited so the columns names appear to be shifted from the values. 

Figure 5: Example file containing 5 spectra to read in 

 

3.2 CIE diagram plots 

There are 5 different CIE color spaces available for plotting. The standard CIE 1931, 1960, and 

1976 2° color spaces, and 2 newer diagrams based on the CIE 170-2:2015 color space. These 

new color spaces use the color coordinates of xF,10, yF,10 and u’F,10 and v’F,10. The CCTF,10 and 

lumens F,10 are also calculated for this 2015 10° color space. These results are given on tab 

4. 

There is no way to convert from x,y to xF,10, yF,10 directly, xF,10, y F,10 must be calculated from the 

spectrum. In these new 2015 plots the conversion from x F,10, y F,10 to u’ F,10 and v’ F,10 is made 

using the standard conversions. It is not clear if this is strictly valid but should be a good 

approximation. It is best to use the u’v’ circles in the new 2015 space over the MacAdams 

ellipses but the software will allow the use of the MacAdams ellipses as an approximation. 
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3.3 Design optimization 

The user selects several LEDs to include in a design, specifies a set of photometric targets 

and the program adjusts the intensity of the LEDs to reach the target design. It is best to first 

find a design that is reasonably close to your target, as described in the previous section. In 

Figure 6 the optimization method is “Target a CRI”. The target CRI is defined as 80 with a CCT 

within 50K of 3000K and a Delta(uv) of 0.002. Also, a minimum R9 of 40 is specified. Only 

some of these parameters need to be specified. If an input box is left blank it will not be 

constrained. Once you click the “Calculate” button the program will prompt you to enter any 

required values that you left blank. In order to optimize for the LPW, the LPW of all of the LEDs 

included in the design must be specified. You will be prompted if any are missing. 

The TM-30 optimization method can work in 2 ways. You can enter targets for the Rf, Rg 

and/or Rf,skin and the program will try to hit these targets. Only one of these needs be entered. 

Another way this method works is if you enter a ‘+’ sin in either the Rf or Rg fields the metric 

with the ‘+’ symbol will be maximized. 

Any other parameters entered will be used a minimum value. 

If your optimization is successful, the new intensity values will be copied to the correct input 

boxes for you to run a complete calculation. If you do not like the design you may return to the 

original intensity values by clicking the “Reset values” button. If the optimization is not 

successful you may need to relax some of the optimization constraints, begin with a better 

design or add more LEDs to the design. 

While design optimization is a very powerful tool it may not be the best approach to find a 

desirable design. One of the drawbacks is that it gives you only one “best” design. There may 

be a design that is very close to the “best” but has some advantages that would lead you to 

select it over the “best” design if you were aware of it. 
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Figure 6: Portion of the main window used to define the optimization targets 
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4 Other functionality 

4.1 Filters 

A filter is used in some applications to control some aspect of the light. You can enter and save 

a filter much in the same way as a spectrum can be saved. To enter a filter, select the “Filter 

input” “Analysis type” and paste your transmission data directly into the table, click the 

“Calculate” button to have the program check the data. You can then use the “User Filters” 

menu item to save or manipulate your user filters as you would your user spectra. The 

transmission is defined as between 0 and 1 or as a percent from 0 to 100. The units can be 

changed in the “Data” menu item. The saved filters are saved to a plain text file called 

“userFilters.fils”. 

If you use filters, it is helpful to create a user spectrum that has a value of 1 for the intensity at 

all wavelengths. This can be used to check your filters by selecting the constant spectrum and 

a filter. The resultant plot will be a plot of the transmission of the filter. 
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4.2 IES TM-30-18 

The IES TM-30-18 metric is calculated, and the values are displayed in the output sections as 

shown below. 

Figure 7: IES TM-30-18 metric 

 

There are various plots available. These can be accessed using the “IES TM-30-18” and 

“Other Plots” menu items. 
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Figure 8: IES TM-30-18 and other plots menu 

 

The “TM-30” toolbar item shows an overview of the TM-30 report. This report can be 

customized using the “IES TM-30-18 report” in the menu above and a typical report is shown in 

Figure 10. 

Figure 9: TM-30 toolbar 
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Figure 10: TM-30-18 report 
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Figure 11: 3D plot of TM-30 points 

 
(1) This plot can be rotated and/or animated. 

 

 

https://ams-osram.com/support/technical-support-form?category=document-feedback


ColorCalculator 
 Other functionality 

 

  

Software Manual • PUBLIC • Document Feedback  
UG001064 • v1-00 • 2025-Jun-25 18 / 83 

/ 

4.3 Color quality scale (CQS) 

The Color Quality Scale is being developed by NIST (National Institute of Science and 

Technology) as a possible replacement for the Color Rendering Index (CRI) for use with LED 

light sources. A full description of the CQS is given in W. Davis, Y. Ohno, Optical Engineering, 

v49(3), 033602 (March 2010).  

The user can switch back-and-forth between the CRI and CQS using the tabs at bottom left of 

the main window as highlighted below. 

Figure 12: Color quality scale (CQS) 

 

4.4 Colors 

The individual values in the CRI and CQS scales (R1-R14 and Q1-Q15) give a measure as to 

how well the test source will render a color as compared to the reference source (a black body 

at the same CCT). The individual colors in the CRI and CQS scales were chosen for their 

general applicability. However, in some cases, you may want to see how a different color will 

be rendered. To do this you can define a “user color”. A user color is defined by entering the 

spectral reflectance representing the color. The measure of how well this color will be rendered 

compared to the reference source will be calculated using the CQS formulation and written to 

the “photometry.txt” file for each user color checked. The user colors can be managed in the 

same manner as the user filters. The reflectance is defined as 0 and 1 or as a percent from 0 

to 100. The saved colors are saved to a plain text file called “userColors.cols”. 
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4.5 Custom CIE plots and delta(uv) 

The delta(uv) is a measure of the distance a point is from the black body locus in u-v space. 

The delta(u’v’) is a measure of the distance a point is from the black body locus in u’-v’ space. 

For “white” light you generally want delta(uv) to be below 0.0020. If you have x,y data and want 

to plot it on a CIE diagram or calculate the CCT or delta(uv) values you can click the button 

with the CIE icon with the “C” near the top of the main window. A new window will open where 

you can enter your data and have the program plot your points and calculate the desired 

values. This can also be used to plot more than one point on the CIE diagram. 

Figure 13: CIE icon 

 

If you have several spectra you want to plot at the same time you can take the following steps. 

After a calculation click the “x,y” button near the top of the main window. This will save the x,y 

data for the spectrum that was just calculated. Repeat this for as many spectra as you wish, 

click the button, and in the new window that opens click the “x,y” button. The saved x,y pairs 

will be written into the table. Then click the “calculate” button to plot the data. 

Figure 14: “x,y” button 

 

You can clear the saved x,y pairs by clicking the “Data->Clear all saved x,y values” menu item 

on the main window or by restarting the program. You can also check several spectra and 

press the “Cal Individual” button. This will calculate each checked spectra individually and 

automatically save the x,y point. These can then be pasted into the Duv table using the 

method described above. 

From this window you have several features such as; change plot symbols, show/hide the 

MacAdams ellipses and/or u’v’ circles for the individual points. You can also display one 

MacAdams ellipse centered on all of your points. You can also enter only the CCT and the 

program will calculate the x,y for a point on the black body at this CCT. This is useful for 

adding reference points to a plot. 
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If you left-click on a plot symbol you will see the pop-up as shown in Figure 16. You can select 

the symbol for each individual point. You can apply the same symbol to several points at once 

if the points are in adjacent rows. To do this you click on the first row, then press “cancel” at 

the bottom, then hold down the shift key and press the plot symbol in the last row and pick 

your symbol. You can save your selected plot symbols and point labels to a file to use later 

using the “Save as…” menu item. The information will be written to a text file. If you have a lot 

of points with complicated symbol and text selections you can create this file yourself. The 

symbol shapes go left-to-right from 0 to 9, the colors go top-to-bottom from 0 to 19. The data 

must be separated by either spaces or tabs and the labels (if present) must be enclosed in 

double quotes. You should first save a file using the program so see the exact format. 

You can display predefined gamuts or define your own. You can also enter your own ellipse 

definitions.  

See the “Help” menu item on this window for more information. 

Figure 15: Input form for the delta(uv) calculations 
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Figure 16: Plot symbols and colors 
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4.6 R-values plots 

You can make a plot of the R-values or Q-values, depending on which metric is selected. After 

a calculation click the button circled in red below. 

Figure 17: R-values plots 

 

You will see a plot similar to the one below (Figure 18). 

Figure 18: R-value plot 

 

You can plot the R-values from several spectra on the same plot by saving the R-values by 

clicking the button circled in red below. You can clear the saved R-values by clicking the “Data-

>Clear all saved Rvalues” menu item on the main window or by restarting the program. 
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Figure 19: Plot the r-values from several spectra 

 

4.7 Subtract blue peak 

The “Subtract blue peak” option will automatically fit the blue peak and subtract it from the 

spectrum. 

The amount of watts in the fitted blue peak and the remaining peak (called the phosphor peak) 

will be reported in the output. The spectrum without the blue peak will be plotted as a solid 

black line so the user can see the fit and evaluate if it is reasonable. The calculated watts in 

each peak are usually good to within 10%. These values only are meaningful for LED sources. 
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Figure 20: Spectrum with the blue peak fit 
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4.8 Evaluation of binning 

The effects of bin selection can be simulated using the “Other Calculations->Calculate binning 

from x, y and lumens…” menu item. You enter the information for your design in terms of the 

LEDs used and their lumen levels. Enter the color and lumen bin information and a Monte 

Carlo simulation is used to generate several thousand data points which are then used to show 

the expected color spread on the CIE diagram and in terms of MacAdam ellipses. The only 

option available in this simulation is whether or not to skew the bins of the non-pure color 

LEDs. The figure below shows a typical skewed bin. You can see the effect by only checking 

the bin to be skewed and see if you like the effect. 

Figure 21: Typical skewed bin 
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Figure 22: With skew effect  Figure 23: Without skew effect 
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4.9 Other plot types 

4.9.1 Spectrum plots 

You can save the plot of a spectrum to a file as a bitmap image. To save the spectrum click the 

button circled in red below. A window will open with only the spectrum plot in it. You can resize 

the plot and save it to a file. 

Figure 24: Save the plot of a spectrum to a file as a bitmap image 

 

4.9.2 CIE plots 

You can save the plots of the CIE diagram to a file as a bitmap image. To save the CIE 

diagram click the button circled in red below. A window will open with only the CIE diagram plot 

in it. You can resize the plot and save it to a file. There are several options in the menu of this 

window that allow you to tailor the plot in many ways. The display of the MacAdam ellipses can 

also be controlled in this window. 

Figure 25: Save the plots of the CIE diagram to a file as a bitmap image 

 

 

 

https://ams-osram.com/support/technical-support-form?category=document-feedback


ColorCalculator 
 Other functionality 

 

  

Software Manual • PUBLIC • Document Feedback  
UG001064 • v1-00 • 2025-Jun-25 28 / 83 

/ 

4.9.3 Matching plots 

If you check the “Matching->Matching mode” menu item a new column will be added to the 

table. You can paste a spectrum into the column labelled “Matching”. When you calculate the 

spectrum this “matching” plot will also be plotted. You can also select to use the photopic curve 

as the matching spectrum by checking the appropriate box in the “Matching” menu item. 

4.9.4 CIELAB plots 

You can make and save CIELAB plots of either the CRI, CQS or user colors to a file as a 

bitmap image. To display the CIELAB plot click the button circled in red below. A window will 

open with the CIELAB plot in it. You can resize the plot and save it to a file. The CMCCAT2000 

chromatic adaptation is used to correct the CQS and user colors and the von Kries chromatic 

adaptation is used to correct the colors. The plot can display the results as individual points of 

as vectors connecting the test and reference points, color rendering vectors (CRV). You can 

also make these types of plots using any user colors you have any defined and checked. You 

can also plot MacAdam ellipses and/or u’v’ circles on the plot. The vectors can also be scaled 

by the size of the corresponding MacAdam ellipse. The scaling is helpful in that vectors of the 

same size will indicates that the color shifts are effectively similar. The ellipses area always 

calculated assuming L* is 100. 

Figure 26: Display the CIELAB plot 

 

 

https://ams-osram.com/support/technical-support-form?category=document-feedback


ColorCalculator 
 Other functionality 

 

  

Software Manual • PUBLIC • Document Feedback  
UG001064 • v1-00 • 2025-Jun-25 29 / 83 

/ 

Figure 27: CIELAB plot of the 14 r-values for the reference and test light source 

 

Figure 28: CIELAB plot of the 14 r-values for the reference and test light source showing color rendering 

vectors (CRV) 
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Figure 28. CIELAB plot of the 14 R-values for the reference and test light source showing color 

rendering vectors (CRV). A vector pointing toward the center indicates that a particular color is 

under saturated, a vector pointing away from the center indicates that the color is 

oversaturated. Vectors pointing in a rotational direction indicate that there is a shift in hue for a 

color. Longer vectors indicate larger shifts in color and/or saturation. 

Once the plot is displayed you can list the L*, a* and b* values (and related metrics) in a table 

by clicking the “Data->Show the data values in a table” menu item. 

Figure 29: Data menu 

 

Figure 30: Values used to make the CIELAB plot 
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4.9.5 Color rendering plots 

How well each color is rendered can be seen using the “color patch” plot, Figure 32. The plot 

can be seen using the “Other plots->Show color patches of R, Q or user colors” menu item. 

You can also show user colors, if you have any defined and checked, using the “Plot type” 

menu item. Note, the colors are only approximate and are rendered as sRBG assuming a 

gamma of 2.2 and normalized to 100 lumens. 

The CMCCAT2000 chromatic adaptation is used to correct the colors and the source 

illumination is D65. 

Figure 31: Plot type menu 

 

Figure 32: Color patch plot of the 15 r-values for the reference and test light source 
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4.9.6 IES TM-30-18 

After a calculation is performed, plots according to the IES TM-30-18 standard can be made. 

There are several different types of plot available in TM-30-18. You have to use the “Image 

Type” menu command on some of the plot windows to switch between image types. The 

numeric results are displayed on tab #2. 

Figure 33: IES TM-30-18 
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4.10 Other features 

4.10.1 Generic pure color LEDs 

You can also display what are called “generic pure color LEDs” in addition to the standard 

packaged LEDs shown by default. You can control what types of LEDs are displayed with the 

“Other options” menu item. The “generic pure color LEDs” are mainly of interest to designers 

using the “Total combinations” method previously described. These LEDs have their peak 

shapes defined by Gaussian fits. Each peak is represented by a fit of three individual 

Gaussians which were derived by fitting to experimental data. 

The peak shapes change with the dominate wavelength. When these LEDs are shown the 

“Total combinations” window looks as shown below. In addition to the standard LEDs you can 

choose these generic LEDs and include the wavelength variation in a combinations run. 

4.10.2 Black body and daylight spectra 

You can display the spectrum of a black body or reconstituted daylight at any CCT. This can 

then be saved as a user spectrum or used as a matching plot. 

4.10.3 Pure color and gaussian peaks 

You can have the program generate a pure color peaks or simple Gaussian peak to represent 

an LED. 

Click the “User Spectra->Generate user spectra from pure color or Gaussian peaks…” menu 

item. Select the LED type, then enter the peak information and program will generate the 

spectra and add it to your user spectra. You can generate many of the same type of peak, with 

different parameters, at once. 
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Figure 34: Generate pure color LED or gaussian spectra 
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4.10.4 MacAdam ellipses 

The program will calculate the points for a MacAdam ellipse for use in other plotting software. 

Use the “Other Options->Calculate coordinates of MacAdam ellipse…” to display this window: 

Figure 35: Other calculations menu 
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Figure 36: Calculate ellipse/circle coordinates 

 

You can enter the ellipse center and the other parameters and the points describing the ellipse 

will be written to the table. These parameters are always for a 1-step ellipse. Note that the 

ellipse is based on equations from: Chickering, JOSA V57 n4, "Optimization of the MacAdam-

Modified 1965 Friele Color-Difference Formula" and Chickering, JOSA V61 n1, "FMC Color-

Difference Formulas: Clarification Concerning Usage". 
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4.10.5 Adding color points 

You can add a series of x,y and lumen value to see the resultant color point. 

Figure 37: Input form for the additive x,y and lumen calculations 
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4.10.6 Calculating CCT, Duv, Ldom and Purity from x,y or u’v’ 

You can enter x,y (or u’v’) values and calculate the CCT, Duv, dominant wavelength and 

purity. The dominant wavelength and purity depend on the reference point used; this can be 

selected by the user. 

Figure 38: Other calculations menu 
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4.10.7 Calculating x,y from CCT and Duv 

You can enter values for the CCT and Duv and have the program calculate the corresponding 

x,y color points. The program solves for the x,y and then uses these to redo the forward 

calculation to calculate the CCT and Duv so you can compare the calculated to inputted values 

as a check on the solution. 

Figure 39: Calculating x,y from CCT and Duv 
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4.10.8 Convert between different coordinate systems 

You can convert between different sets of color coordinates. Enter any set (xy or uv or u’v’ or 

XYZ or L*a*b*) and the others sets will be calculated. You can enter a lumen level or, if none is 

specified, the program uses a default of 100. For conversion to and from CIELab space a white 

point must be entered. 

If you are not interested in the L*a*b* values this white point can be ignored. 

Figure 40: Convert between different coordinate systems 
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4.10.9 Natural colour system (NCS) 

The Natural Colour System®© is a color notation system developed and supported by NCS 

Colour and is the property of and used on licence from NCS Colour AB, Stockholm 2013. The 

system is comprised of 40 hues, a blackness level (vertical axis) and a chromaticness level 

(horizontal axis). More information can be found at ncscolour.com/en-int 

These colors can be selected and used as user colors and can then be used to generate color 

rendering vector plots (CRV) to give a designer an indication as to how a light source will 

render a wide range of colors, section C. Figure 42 was made using all 1950 of the NCS colors 

as user colors. This plot is much more informative than the similar plots shown in Figure 18 

which was made using the 14 CRI R-value colors. 
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Figure 41: Color systems menu 
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Figure 42: CIEL*a*b* plot of the 1950 NCS colors for the reference and test light source showing color 

rendering vectors (CRV) 

 

4.10.10 Class A light 

J.P. Freyssinier and M.S. Rea of the Lighting Research Center at Rensselaer Polytechnic 

Institute and Alliance for Solid-State Illumination Systems and Technologies (ASSIST) have 

proposed a specification for what they call “Class A” lighting. Detailed information on this work 

can be found at lrc.rpi.edu/programs/solidstate/assist/pdf/SIL-

2012_FreyssinierRea_WhiteLighting.pdf  
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4.10.11 Three color mixing 

The “Other options->Calculate 3 color mixing based on x,y…” menu item will show the 

following window. Enter the x,y coordinates of the three color sources in the top table. In the 

“Targets” table enter either the CCT and Duv or the x and y of the desired mixed light and the 

required lumen level of each of the three colors will be calculated. You can either enter a value 

in the “Total lm” column or leave it empty. If it is left empty then a default value of 100 lumens 

will be used. 

Figure 43: Three color mixing 
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4.10.12 Spectra mixing 

The “Other options->Calculate color mixing based on spectra…” menu item will show the 

following window. The checked spectra (up to 4) from the main window will be used in these 

calculations. The watts or milliwatts of each color can be entered and the photometry will be 

calculated. 

Figure 44: Spectra mixing 
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4.10.13 Maximum lumens from a color mix 

The “Other options-> Calculate maximum lumens from color mix...” menu item will show the 

following window. This is designed to calculate the maximum lumens you can get from a set of 

LEDs and a color mix. You define the performance of the LEDs in the upper table, inputting the 

lumens and visible watts at maximum power. In the lower table you enter your color mix, either 

based on the percent of visible watts in the spectrum from each LEDs or on the absolute watt 

level. The program then calculates the maximum lumens achievable and the intensity limiting 

LED and the duty cycle. This calculation is also available in the “Run combinations” method 

described in section III/3 of this report. 

Figure 45: Maximum lumens from a color mix 
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4.10.14 Circadian system response 

The “Other options->Calculate Circadian system response…” menu item will show the 

following window. 

First you must select and perform a calculation from the main window. You can enter the Lux 

values and have the program calculate the resultant CLA and CS values, or enter a target CS 

value and the required Lux and CLA values will be calculated. The Circadian system response 

calculation is based on work by M.S. Rea, M.G. Figueiro, J.D. Bullough, A. Bierman and R. 

Hamner at the Lighting Research Center, Rensselaer Polytechnic Institute, Troy, New York, 

USA. 

Figure 46: CIE plot 
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4.10.15 TLCI-2012 metric 

The TLCI-2012 metric refers to the Television Lighting Consistency Index, as specified in EBU 

Tech 3355. 

It is used to evaluate the suitability of a light source for use in television. A complete 

description is available on the web at tech.ebu.ch/tlci-2012. Below shows sample output for the 

2700K white LED included in the program. There are 2 buttons with slightly different TLCI 

calculations. The button on the left will run the calculation with the reference light source as 

defined in the standard. The button on the right will allow the user to select the spectrum to use 

as the reference light source. 

Figure 47: Select the spectrum to use as the reference light source 

 

Figure 48: Sample output for the 2700K white LED 
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4.10.16 Horticulture 

The leaf icon on the toolbar will display the photon flux in specific wavelength ranges. The 

wavelength ban (300-1050) is only displayed if there is any flex above 800 nm. 

Figure 49: Leaf icon 
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5 Description of menu commands 
A brief description of each menu command will be given. For many of these the meaning is 

obvious or it can be easily ascertained by trying them. 

5.1 File menu 

5.1.1 “Open design file…” 

Open a previously saved design file. This contains all of the settings you can set in the UI. 

5.1.2 “Save design as…” 

Saves the current state of the UI to a file. These setting can be read back in using the “Open 

design file” command. 

5.1.3 “Clear recent project list” 

Clears the list of the recently used design files. This will be grayed out if no design files have 

been used. 

5.1.4 “Open photometry.txt file” 

Opens the photometry.txt file in a simple text editor. This file contains a surrey of all of the runs 

performed since the program was last started. It is overwritten each time the program is 

restarted. This file is only written to if the “Write to Excel” button is pressed or if the menu item 

“Data->Write photometry data to a file (photometry.txt)” is checked. 
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5.1.5 “Open photometry.xls file” 

Opens the photometry.xls file in excel. This file contains a surrey of all of the runs performed 

since the program was last started. It is overwritten each time the program is restarted. This 

file is only written to if the “Write to Excel” button is pressed or if the menu item “Data->Write 

photometry data to Excel file (photometry.xls)” is checked. 

5.1.6 “Exit” 

Guess what this does? 

5.2 Edit menu 

5.2.1 “Select entire table” 

Selects the content of the table where the spectrum is displayed. 

5.2.2 “Copy selection to clipboard” 

Copies the selected cells in the table to the clipboard. These values can then be pasted in 

other software. 

5.2.3 “Paste selection to clipboard” 

Allows values to be copied from other software, such as Excel, to be pasted into the table. 

These values must already be in the clipboard and can only be pasted when the program in 

the one of the input modes. 
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5.3 Inputs menu 

5.3.1 “Input power units (milliWatts)” 

Sets the watts units for the spectra to milliwatts. These are the values you enter into the UI to 

set how much of each spectrum you have. This does not affect values of any spectra which 

are read from files. 

5.3.2 “Input power units (watts)” 

Sets the watts units for the spectra to watts. These are the values you enter into the UI to set 

how much of each spectrum you have. This does not affect values of any spectra which are 

read from files. 

5.3.3 “Fill empty input intensity fields with lumens” 

If both the lumens and visible watts input field are empty the lumens field will be filled with the 

default values. 

5.3.4 “Fill empty input intensity fields with visible watts” 

If both the lumens and visible watts input field are empty the visible watts field will be filled with 

the default values. 

5.3.5 “Input units for filters and colors (fraction 0-1)” 

Sets the input units for filters and colors to fractional values. The values must be in the range 

of 0 to 1. 

5.3.6 “Input units for filters and colors (percent 0-100)” 

Sets the input units for filters and colors to percentage values. The values must be in the range 

of 0 to 100. 
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5.3.7 “Spectrum from 360-830nm (2nm)” 

Set the wavelength range and interval for the spectrum copied into the main table for the 

“Direct spectrum input” mode to 360-830nm in 2 nm steps. 

5.3.8 “Spectrum from 360-830nm (1nm)” 

Set the wavelength range and interval for the spectrum copied into the main table for the 

“Direct spectrum input” mode to 360-830nm in 1 nm steps. 

5.3.9 “Spectrum from 380-780nm (2nm)” 

Set the wavelength range and interval for the spectrum copied into the main table for the 

“Direct spectrum input” mode to 380-780nm in 2 nm steps. 

5.3.10 “Free format spectrum” 

Set the wavelength range and interval for the spectrum copied into the main table for the 

“Direct spectrum input” mode to any range and any interval. The program does the photometry 

calculations from 360 to 830 in 2 nm steps. The inputted data will be extrapolated to fit this 

range and set to 0 if not data is provided. This input format is the most general and can always 

be used. 

5.3.11 “Input units for spectrum” 

Set the units of the inputted spectrum to either: W/nm, milliWatts/nm, microWatts/nm or 

photon/s. These units are only in effect when “Direct spectrum input” is checked. 

5.3.12 “Invert values in table” 

When pasting in a spectrum, filter or color into the table requires that the wavelengths values 

are arranged short to long, 360-830nm. If your data is in the opposite order (long to short) you 

can paste it in, then click this command and the values will be flipped in the table. 
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5.3.13 “Limit umol/s-W to 400-700nm” 

Limits the calculation of the umol/s-W to the range of 400-700nm. If this is not checked then 

the umol/s-W will be calculated over the range of 360-830nm of 360-1050nm if the “Include IR” 

option is checked. 

5.3.14 “Hide spectrum data when possible” 

The table with the spectrum data will be hidden unless you are in one of the input modes or 

are displaying a matching spectrum. 

5.3.15 “Set empty cells in spectrum to 0” 

When inputting a spectrum any wavelength values not entered in the table will be set to zero. If 

this is not checked then any empty cells will cause an error. 

5.3.16 “Use original spectral intensity if lumens or watts are blank” 

If this is checked the user can leave both the watts and lumen values empty and the program 

will use the value of the original spectrum. If this is not checked then any empty cells will cause 

an error. 

5.3.17 “Clear spectrum data from table” 

Clear the table of any user entered data. This can also be accomplished using the red “x” 

button on the toolbar. 

5.3.18 “Clear all saved x,y values (0/2000)” 

Clears any saved x,y data from memory. After a spectrum is calculated you can click the “x,y” 

toolbar button to save the x,y values to an array. Also, if you selected several spectra and click 

the “Cal. Individual” button then each of the checked spectrum will be calculated individually 

and not summed, then the x,y values will automatically be saved to the x,y array. These saved 

values can then be pated into the Duv table (accessible by clicking the Duv toolbar button) and 

used to make more customizable CIE plots. 
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5.3.19 “Clear all saved r-values and q-values (0/7)” 

Clears any saved R, Q data from memory. After a spectrum is calculated you can click the 

“Rn” toolbar button to save the R and Q values to an array. These can then be used to make R 

or Q values plots like that shown in Figure 18. You can use the current values or all of the 

saved values to make your plot by using the menu commands in the R-values plot window 

(accessible with a toolbar button). 

5.3.20 “Clear input data on start-up” 

By default the program will start each time with the final values from the last time it was run. 

Checking this will always start the program with no spectrum selected and lumen or watt 

values. 

5.3.21 “Reset all program default values” 

Reset any user changeable values to their default settings with no spectrum selected and no 

lumen or watt values. This can also be accomplished by deleting the ColorCalculator.ini file 

located in the same directory as the ColorCalculator.exe file. Note that any user spectra, filters 

or colors will not be affected; these are stored in separate files. 

5.3.22 “Update decimal format” 

The program is “international” aware, meaning that it asked the operating system whether to 

use a dot or comma for the decimal separator. You can reset this is the operation system and 

use this command to have the program reset itself to use the new value. 
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5.4 Outputs menu 

5.4.1 “Write current spectrum data to a text file” 

The current contents of the spectrum table will be written to a text file of your choosing. This 

can be read in using another command. This is in addition to being able to cut and paste the 

data to a file for saving. 

5.4.2 “Write x,y, Duv with 4 decimals” 

Writes the x, y and Duv values with 4 decimal points resolution. 

5.4.3 “Write x,y, Duv with 6 decimals” 

Writes the x, y and Duv values with 6 decimal points resolution. 

5.4.4 “Write the photometry data to a file (photometry.txt)” 

The results of each calculation will be written to a text file. 

5.4.5 “Write the gamuts, COI, Class A, TLCI & umol/s-W to the photometry.txt file” 

Write these quantities to the text file after each run. 

5.4.6 “Write all photometry data to Excel file (photometry.txt)” 

The main photometric quantities will be written to an Excel file after each run. 

5.4.7 “Write the CIE 2015 CCT(F10), x(F10) and y(F10) values to Excel file (photometry.xls)” 

It’s all in the title. 
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5.4.8 “Write the TM-30-18 bin Rf,bi values to Excel file (photometry.xls)” 

It’s all in the title. 

5.4.9 “Write u’v’ for the r-values, q-values, and any checked user colors to excel file 

(CRI_CQS_u’u’.xls)” Calculates the u’v’ for the individual R-colors, Q-colors and any user 

colors under the test and reference light sources and writes then to an Excel file names 

CRI_CQS_u’u’.xls. 

5.4.10 “Write the binning runs to a file” 

The individual x,y points from a binning run will be written to a text file. 

5.4.11 “Gamut based on 1976 (u'v') diagram” 

The gamut areas based on the 1976 diagram will be displayed in the UI. 

5.4.12 “Gamut based on 1960 (uv) diagram” 

The gamut areas based on the 1960 diagram will be displayed in the UI. Note that the gamuts 

themselves are ratios and have the same values on the 1976 and 1960 diagrams. Only the 

gamut areas are different. 

5.4.13 “Limit umol/s and umol/J to 400 nm to 700 nm” 

The calculation of these quantifies will be limited to the wavelength range of 400 nm to 700 nm 

instead of the usual 360 nm to 830 nm. 
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5.5 Matching menu 

5.5.1 “Matching mode” 

Adds a third column to the spectrum table. An additional spectrum can be pasted into this 3rd 

column to be plotted along with the original spectrum. The name of the matching spectrum can 

be changed in the spectrum plot window. 

5.5.2 “Plot normalized data” 

Normalize the original and matching spectra before plotting. 

5.5.3 “User entered” 

The user pastes the desired spectrum into the table. 

5.5.4 “Use the black body curve as the matching spectrum” 

The user can enter a value for the black body spectrum and it will be calculated and used as 

the matching spectrum. 

5.5.5 “Use the reconstituted daylight curve as the matching spectrum” 

The user can enter a value for the reconstituted daylight spectrum and it will be calculated and 

used as the matching spectrum 

5.5.6 “Use the 1931 2° photopic (𝒚̅) curve as the matching spectrum” 

Use the 1931 2° photopic (𝑦̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 
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5.5.7 “Use the 1931 2° photopic (𝒙̅) curve as the matching spectrum” 

Use the 1931 2° photopic (𝑥̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.8 “Use the 1931 2° photopic (𝒛̅) curve as the matching spectrum” 

Use the 1931 2° photopic (𝑧̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.9 “Use the 1931 2° scotopic (𝒚̅) curve as the matching spectrum” 

Use the 1931 2° scotopic (𝑦̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.10 “Use the 1960 10° photopic (𝒚̅) curve as the matching spectrum” 

Use the 1960 10° photopic (𝑦̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.11 “Use the 1960 10° photopic (𝒙̅) curve as the matching spectrum” 

Use the 1960 10° photopic (𝑥̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.12 “Use the 1960 10° photopic (𝒛̅) curve as the matching spectrum” 

Use the 1960 10° photopic (𝑧̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.13 “Use the 2015 2° photopic (𝒚̅) curve as the matching spectrum” 

Use the 2015 2° photopic (𝑦̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 
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5.5.14 “Use the 2015 2° photopic (𝒙̅) curve as the matching spectrum” 

Use the 2015 2° photopic (𝑥̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.15 “Use the 2015 2° photopic (𝒛̅) curve as the matching spectrum” 

Use the 2015 2° photopic (𝑧̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.16 “Use the 2015 10° photopic (𝒚̅) curve as the matching spectrum” 

Use the 2015 10° photopic (𝑦̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.17 “Use the 2015 10° photopic (𝒙̅) curve as the matching spectrum” 

Use the 2015 10° photopic (𝑥̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 

5.5.18 “Use the 2015 10° photopic (𝒛̅) curve as the matching spectrum” 

Use the 2015 10° photopic (𝑧̅) curve as the matching spectrum, the spectra will be normalized 

before plotting. 
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5.6 User spectra menu 

5.6.1 “Save as a user spectrum…” 

After a spectrum has been calculated it can be saved for future use. The spectrum can be from 

a combination of existing spectra, pasted into the table or read from a file. You can enter any 

name you like and enter an LPW if it is known. Any saved user spectra are saved to a file 

called “userSpectra.spec” in the directory where the ColorCalculator.exe is. It is a plain ascii 

file and can be read in most text editors. You can move the file around, make copies or 

rename it. Each time the program starts it looks for a file called “userSpectra.spec” and reads 

in any spectra found within. 

5.6.2 “Import user spectra (add to current ones)…” 

Open and read in saved spectra. You will be prompted for a file to open. This file must be in 

the correct format so it is almost always a previously renamed “userSpectra.spec” file. The 

spectra read-in will be added to any existing user spectra. 

5.6.3 “Read a saved user spectra file (replace current ones)…” 

Open and read in saved spectra. You will be prompted for a file to open. This file must be in 

the correct format so it is almost always a previously renamed “UserSpectra.spec” file. The 

spectra read-in will replaced any existing user spectra. A file called “userSpectra_bck.spec” will 

contain the contents of the old “userSpectra.spec” file if any existed. 

5.6.4 “Edit user spectra…” 

Opens a new window allowing the user to rename, reorder, change the LPW, or delete any 

user spectra in the current file. 

5.6.5 “Create user spectra from pure color or Gaussian peaks...” 

You can enter the peak parameters to define a pure color LED peak or a Gaussian peak which 

will be added to your user spectra. 
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5.6.6 “Standard illuminates” 

You can select standard illuminates to be added to your user spectra. 

5.6.7 “Import *.isd SpecWin data file…” 

You can select files created by the SpecWin software and directly import them as user spectra. 

5.6.8 “Import *.txt SpectraSuite data file…” 

You can select files created by the SpectraSuite software and directly import them as user 

spectra. You will be prompted to enter the intensity units (W/nm, mW/nm or μW/nm) for the 

spectrum. 

5.6.9 “Import *spdx (IES XML) spectrum data file…” 

You can select files in the IES XML and directly import them as user spectra. 

5.6.10 “Import data file (1st column is nm, 2nd column is intensity) …” 

These files can be from any source and any wavelength range or interval. The data can be 

separated by spaces or tabs, commas may also work depending on the symbol used as the 

decimal point. You will be prompted to enter the intensity units (W/nm, mW/nm or μW/nm) for 

the spectrum. In this file format you can have up to 100 spectra in the same file in different 

columns as long as they all have the same wavelengths, only the first column is used for the 

wavelength, the other columns will be considered as holding the intensity. 

5.6.11 “Import data file (1st column is intensity, 2nd column is nm) …” 

These files can be from any source and any wavelength range or interval. The data can be 

separated by spaces or tabs, commas may also work depending on the symbol used as the 

decimal point. You will be prompted to enter the intensity units (W/nm, mW/nm or μW/nm) for 

the spectrum. In this file format you can have only 1 spectrum in the file. 
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5.6.12 “Include the filename in the spectrum name” 

The filename will be prepended to the spectrum name when it is read into the software. You 

can rename the spectra later using the “Edit user spectra…” command. 

5.7 User filters menu 

5.7.1 “Save as a user filter…” 

After a filter has been entered and calculated it can be saved for future use. The filter must 

paste into the table when in “Filter input” mode. You can enter any name you like. Any saved 

user filters are saved to a file called “userFilters.fils” in the directory where the 

ColorCalculator.exe is. It is a plain ascii file and can be read in most text editors. You can 

move the file around, make copies or rename it. Each time the program starts it looks for a file 

called “userFilters.fils” and reads in any filters found within. 

5.7.2 “Import user filters (add to current ones)…” 

Open and read in saved filters. You will be prompted for a file to open. This file must be in the 

correct format so it is almost always a previously renamed “userFilters.fils” file. The filters 

readin will be added to any existing user spectra. 

5.7.3 “Read a saved user filters file (replace current ones)…” 

Open and read in saved filters. You will be prompted for a file to open. This file must be in the 

correct format so it is almost always a previously renamed “userFilters.fils” file. The spectra 

read-in will replaced any existing user filters. A file called “userFilters_bck.fils” will contain the 

contents of the old “userFilters.fils” file if any existed. 

5.7.4 “Edit user filters…” 

Opens a new window allowing the user to rename, reorder, or delete any user filters in the 

current file. 
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5.7.5 “Import data file (1st column is nm, 2nd column is transmission) …” 

These files can be from any source and any wavelength range or interval. The data can be 

separated by spaces or tabs, commas may also work depending on the symbol used as the 

decimal point. In this file format you can have up to 100 transmission curves in the same file in 

different columns as long as they all have the same wavelengths, only the first column is used 

for the wavelength, the other columns will be considered as holding the transmission. 

5.7.6 “Import data file (1st column is transmission, 2nd column is nm) …” 

These files can be from any source and any wavelength range or interval. The data can be 

separated by spaces or tabs, commas may also work depending on the symbol used as the 

decimal point. In this file format you can have only 1 transmission curve in the file. 

5.7.7 “Include the filename in the filter name” 

The filename will be prepended to the filter name when it is read into the software. You can 

rename the filters later using the “Edit user filters…” command. 

5.7.8 “Uncheck all user filters” 

Uncheck any checked user filters. 

5.7.9 “Allow values greater than 1 or 100%” 

If this option is checked than values greater than 1 or 100% will be allowed. If this is not 

checked a warning will be shown. 
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5.8 User colors menu 

5.8.1 “Save as a user color…” 

After a color has been entered and calculated it can be saved for future use. The color must 

paste into the table when in “Color input” mode. You can enter any name you like. Any saved 

user colors are saved to a file called “userColors.cols” in the directory where the 

ColorCalculator.exe is. It is a plain ascii file and can be read in most text editors. You can 

move the file around, make copies or rename it. Each time the program starts it looks for a file 

called “userColors.cols” and reads in any colors found within. 

5.8.2 “Import user colors (add to current ones)…” 

Open and read in saved colors. You will be prompted for a file to open. This file must be in the 

correct format so it is almost always a previously renamed “userColors.cols” file. The colors 

read-in will be added to any existing user colors. 

5.8.3 “Read a saved user colors file (replace current ones)…” 

Open and read in saved colors. You will be prompted for a file to open. This file must be in the 

correct format so it is almost always a previously renamed “userColors.cols” file. The spectra 

read-in will replaced any existing user colors. A file called “userColors_bck.cols” will contain 

the contents of the old “userColors.cols” file if any existed. 

5.8.4 “Edit user colors …” 

Opens a new window allowing the user to rename, reorder, or delete any user colors in the 

current file. 
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5.8.5 “Import data file (1st column is nm, 2nd column is reflectance) …” 

These files can be from any source and any wavelength range or interval. The data can be 

separated by spaces or tabs, commas may also work depending on the symbol used as the 

decimal point. In this file format you can have up to 100 reflectance curves in the same file in 

different columns as long as they all have the same wavelengths, only the first column is used 

for the wavelength, the other columns will be considered as holding the reflectance. 

5.8.6 “Import data file (1st column is reflectance, 2nd column is nm) …” 

These files can be from any source and any wavelength range or interval. The data can be 

separated by spaces or tabs, commas may also work depending on the symbol used as the 

decimal point. In this file format you can have only 1 reflectance curve in the file. 

5.8.7 “Include the filename in the color name” 

The filename will be prepended to the color name when it is read into the software. You can 

rename the colors later using the “Edit user colors…” command. 

5.8.8 “Check all user colors” 

Check all of the user colors. 

5.8.9 “Uncheck all user colors” 

Uncheck any checked user colors. 
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5.9 CIE plot menu 

More options are available in the main CIE diagram window. Additional customizations 

involving MacAdams ellipses and point symbols, colors and labels are also available from the 

Duv toolbar button. 

5.9.1 “Color filled CIE space” 

Fill the CIE diagram with color. 

5.9.2 “Unfilled CIE space” 

Do not fill the CIE diagram with color, it will be white. 

5.9.3 “Show grid lines” 

Show grid lines in the CIE plot. 

5.9.4 “Locus lines” 

You can pick which locus to show, black body, daylight, TM-30-18 or none. 

5.9.5 “Show CCT lines” 

Youi can pick from a selection of CCT lines to display. 

5.9.6 “ANSI quadrangles” 

Select to display the various ANSI quadrangles. 
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5.9.7 “Photometry text” 

An abbreviated summary of the photometry will be displayed on the CIE diagram. The location 

of this label can be selected. 

5.9.8 “Out-of-gamut color” 

You can chance the display of the out-of-gamut region of the CIE diagram. This is only active 

when you have a gamut selected. 

5.9.9 “Draw gamut boundary line” 

Determines whether a line is drawn as the gamut is boundary. 

5.9.10 “Gamuts” 

Select standard gamuts to be drawn on the CIE diagram. 

5.9.11 “Solid gamut lines” 

Draws the gamut lines as solid line if checked, if not checked each line is drawn with a different 

dashed line. 

5.9.12 “MacAdam ellipse” 

Select which of the MacAdam ellipses to display. These ellipses are based on equations from: 

Chickering, JOSA V57 n4, 1967, "Optimization of the MacAdam-Modified 1965 Friele Color-

Difference Formula" and Chickering, JOSA V61 n1, 1971, "FMC Color-Difference Formulas: 

Clarification Concerning Usage" 

5.9.13 “u’v’ circles” 

Draw the u’v’ circles, as defined in CIE TN 001:2014, on the CIE diagram. 
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5.9.14 “Ellipse/circle color” 

You can select the color used for the MacAdam ellipse or u’v’ circle. 

5.9.15 “Use thick line” 

You can select whether to use a thick line when drawing the MacAdam ellipse or u’v’ circle. 

5.9.16 “Symbol size” 

Select the size of the x,y point symbol 

5.9.17 “Show raw spectra with points and lines” 

A point representing each individual checked spectra along with a dotted line connecting it to 

the sum of the check spectra will be displayed. 

5.9.18 “Show wavelength markers” 

Show the wavelength markers on the outer CIE horseshoe. 

5.9.19 “Enable smartzoon (center at x,y)” 

Center the CIE diagram at the x,y of the spectrum. 
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5.10 Spectrum plot menu 

More options are available in the main spectrum plot window. 

5.10.1 “Plot with white background” 

Do not fill the plot with color. 

5.10.2 “Plot with rainbow under curve” 

Fill the plot with color only under the curve. 

5.10.3 “Plot with rainbow background” 

Fill the entire plot with color. 

5.10.4 “y-axis is umol/s when input units are photons/s” 

Changes the y-axis units of the plot to umol/s when the input units of the spectrum are 

photons/s. 

5.10.5 “Draw color patch (at 6500K) on plot when plotting colors/filters” 

Display a patch representing the color/filter under 6500K daylight on the plot. 

5.10.6 “Write the photometry or the filter/color name on the plot” 

Display a summary of the photometry or the filter/color name on the plot. 

5.10.7 “Position plot legends top left” 

Draw the caption and color patch in the top left corner. 
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5.10.8 “Position text and color patch top right” 

Draw the caption and color patch in the top right corner. 

5.10.9 “Position text and color patch bottom right” 

Draw the caption and color patch in the bottom right corner. 

5.10.10 “Position plot legends bottom left” 

Draw the caption and color patch in the bottom left corner. 

5.10.11 “Fill the legend background” 

Fill the legend background to mask the plot behind it if they overlap. 

5.10.12 “Keep y-axis for filters and colors at full scale (1 or 100)” 

For filters and color plots do not scale the y-axis, keep it at 1 or 100%. 

5.10.13 “Show grid lines” 

Draw vertical grid lines. 

5.10.14 “Show box around plot” 

Draw the top and right side axis lines. 

5.10.15 “Show color peak lines on plot” 

Draw short vertical lines to indicate the color. This is only useful when you draw an unfilled 

plot, i.e., no rainbow. 
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5.10.16 “Enable mouse wheel zoom” 

When this is checked scrolling the mouse wheel when over the spectrum plot will zoom the 

wavelength axis in or out. The zoom will take place centered at the wavelength where the 

mouse is positioned. 

5.11 IES TM-30-18 menu 

5.11.1 “IES TM-30-18 chroma, hue shifts and Rf histograms for the 16 hues” 

Uses the last calculated spectrum to make the plot. Use the “Image Type” menu item in the 

plot window to switch between the different plot types. 

5.11.2 “IES TM-30-18 color Rf histogram for the reference colors” 

Uses the last calculated spectrum to make the plot. 

5.11.3 “IES TM-30-18 color patches“ 

Uses the last calculated spectrum to make the plot. The appearance of the reference colors 

under the test and reference spectra are displayed. 

5.11.4 “IES TM-30-18 Rg versus Rf plot“ 

Uses the last calculated spectrum to make the plot. 

5.11.5 “IES TM-30-18 color vector graphic and icon plots“ 

Uses the last calculated spectrum to make the plot. Use the “Image Type” menu item in the 

plot window to switch between the two plot types. 
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5.11.6 “IES TM-30-18 gamut area plot“ 

Uses the last calculated spectrum to make the plot. 

5.11.7 “IES TM-30-18 CAM02-UCS plot“ 

Uses the last calculated spectrum to make the plot. 

5.11.8 “IES TM-30-18 report” 

Creates the IES TM-30-18 report as a bitmap. The user is prompted to enter values for the 

various text fields. 

5.11.9 “Use the selected user colors in place of the standard TM-30-18 reference colors” 

The 99 standard reference colors defined in TM-30-18 will be replaced with ones you’ve 

checked. 

5.11.10 “Write IES TM-30-18 J‘a’b‘, Rf,i and Rf,h values to a file…“ 

Write the values for the last calculated spectrum. 

5.12 Other plots menu 

5.12.1 “3D CIE L*a*b* & CAM02-UCS J*a*b* plots with current spectrum” 

Opens a new window where you can enter your own display 3D CIE L*a*b* & CAM02-UCS 

J*a*b* plots and animate these. 

5.12.2 “3D CIE L*a*b* plot with user inputted values...” 

Opens a new windows where you can enter your own L*a*b* values to make a 3D CIELab plot. 
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5.12.3 “CIEL*a*b* plot with user inputted values...” 

Opens a new windows where you can enter your own L*a*b* values to make a CIELab plot. 

5.13 Other calculations menu 

5.13.1 “Calculate CIEDE2000 with user inputted values...” 

Opens a new window where you can L*a*b* values and calculate various CIEDE2000 

quantities. 

5.13.2 “Calculate CCT, Duv, dominant wavelength and purity from x,y…” 

Opens a new window where you can enter x, y values and the corresponding u’v’, CCT and 

Duv values will be calculated. You can also make highly customized CIE plots from this 

window. You can enter x,y points to plot, select different MacAdams ellipses, specify your own, 

change the point size, symbol, color and add captions to the points. This window can also be 

open with the Duv toolbar button. This is the main function to make customized CIE plots. 

5.13.3 “Calculate x,y from CCT & Duv…” 

Opens a new window where you can enter CCT and Duv values and the corresponding x,y 

values are calculated. 

5.13.4 “Convert coordinates (xy/uv/u'v'/XYZ/L*a*b*)...” 

Opens a new window where you can enter one set of coordinates and the other sets of 

coordinates are calculated. 

5.13.5 “Convert between RGB, HSV and HSL systems” 

Opens a new window where you can enter one set of values and the other sets of values are 

calculated. 
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5.13.6 “Convert Cx, Cy to RGB, HSV and HSL systems” 

Opens a new window where you can enter Cx and Cy values and the other sets of values are  

calculated. 

5.13.7 “Calculate gamut area coverage…” 

Opens a new window where you can enter your gamut and have its coverage compared to 

other standard gamuts. 

5.13.8 “Calculate the black body locus and CCT lines…” 

Opens a new window where you can enter minimum and maximum CCT values and the x,y 

coordinated of the black body line will be written to a tab delimited file called 

“blackBodyLocus.txt”. 

5.13.9 “Calculate the coordinates of MacAdams ellipse or u’v’ circle…” 

Opens a new window where you can enter an x,y point along with the size of the MacAdams 

ellipse or the u’v’ circle and points representing the ellipse or circle will be calculated. 

5.13.10 “Calculate circadian system response…” 

Opens a new window where you calculate the circadian/melatonin suppression metric based 

on work by M.S. Rea, M.G. Figueiro, J.D. Bullough, A. Bierman and R. Hamner at the Lighting 

Research Center, Rensselaer Polytechnic Institute, Troy, New York, USA. 

5.13.11 “Calculate binning from x,y and lumens…” 

Opens a new window where you can enter x, y and lumens along with wavelengths and Cx, Cy 

bin widths and Monty Carlo simulations are used to estimate the expected variation in color. 
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5.13.12 “Calculate photometry from x,y and lumens…” 

Opens a new window where you can enter x, y and lumens of several light sources and the 

resultant photometry of all of the light sources combined is calculated. 

5.13.13 “Calculate 3 color mixing based on x,y…” 

Opens a new window where you can enter the x,y values of your three colors. In another table 

you enter the target CCT and Duv or x and y, and the total lumens you want. The program will 

then calculate the lumens required of each of the three colors to hit your target. 

5.13.14 “Calculate maximum lumens from color mix…” 

Opens a new window where you can enter the x,y values of your colors. If you check LEDs in 

the main window and press the “Cal. Individual” button before open this window you wll be 

able to press the “Use last” button to copy the LED data into the table, you can also enter 

values into this table manually. You enter the color mixes in terms of visible watts and the 

maximum lumens you can are reported. 

5.13.15 “Calculate color mixing based on spectra…” 

Opens a new window where you can mix up to 4 spectra. These must be checked in the main 

window before you click this command. You can enter different intensities of these peaks and 

the photometry will be calculated. 

5.13.16 “Multi-design optimization…” 

Opens a new window where you can enter several optimization target designs to run at once. 

5.13.17 “Resample spectrum…” 

Opens a new window where you can paste in a spectrum and resample it at any wavelength 

interval. 
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5.13.18 “Bin substitution…” 

Opens a new window where you select an existing spectrum, then select several other 

spectrum to combine to hit the same x,y color point. 

5.13.19 “Mix by sliders…” 

Opens a new window where you can adjust the amount of each spectra and the wavelength of 

the pure color LEDs using sliders for an interactive experience. 

5.14 Other options menu 

5.14.1 “Resize window to fit screen size” 

When changing screen resolution the main window may be slightly off the screen, this 

command will resize and reposition it so it fits. 

5.14.2 “Reset the working directory to the default directory” 

Sometimes you’ve navigated to a different directory to read some data files. This command will 

reset the directory to the program default. 

5.14.3 “Program font…” 

Change the font used for the UI. 

5.14.4 “Write the R1-R15 colors to a file (R_values.cols)” 

Writes the reflectance spectra of the 15 CIE reference colors to a file. These can then be read-

in as user colors or used in other software. 
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5.14.5 “Write the Q1-Q15 colors to a file (Q_values.cols)” 

Writes the reflectance spectra of the 15 CQS reference colors to a file. These can then be 

read-in as user colors or used in other software. 

5.14.6 “Write the ColorChecker (TLCI) colors to a file (ColorChecker_colors.cols)” 

Writes the reflectance spectra of the ColorChecker (TLCI) reference colors to a file. These can 

then be read-in as user colors or used in other software. 

5.14.7 “Write the CES colors to a file (CES_values.cols)” 

Writes the reflectance spectra of the 99 CES reference colors to a file. These can then be 

read-in as user colors or used in other software. 

5.14.8 “Write photometry coefficients file” 

Writes several of the photometric constant to a file. The following files are written: 

"XYZ_coeff.xls", "TCS_VS_coeff.xls", "CCT_coeff.xls", "daylight_coeff.xls". 

5.14.9 “Write the CIE horseshoe data to an excel file” 

The coordinates of the 1931 2° and 2015 10° horseshoes are written to a file 

(CIE_horseshoe.xls) for use in other software. 

5.14.10 “Play sounds” 

Beeps when a run is completed. 

5.14.11 “Enable sticky menus” 

Keeps certain menus open after a selection is made. 
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5.14.12 “Enable mouse wheel in LEDs input fields (ldom, bin width and output)” 

You can use the mouse wheel to easily change the values of these fields. 

5.14.13 “Show all standard LEDs” 

Shows all of the standard spectra what come with the software. User spectra are shown. 

5.14.14 “Do not show generic pure color standard LEDs” 

Do not show any of the pure color spectra what come with the software. User spectra are 

shown. 

5.14.15 “Do not show IR standard LEDs” 

Do not show the standard spectra for the IR LEDs what come with the software. User spectra 

are shown. 

5.14.16 “Do not show any standard LEDs” 

Do not show any of the spectra what come with the software. User spectra are shown. 

5.14.17 “Show CIE and CQS test colors and TM-30 hue colors” 

Set the background color of the individual R, Q and TM-30 Rf values cell to an approximate 

representation of the actual R, Q or TM-30 hue value at D65. 

5.14.18 “Show tab highlight colors” 

Highlights the “Spectra”, “Filters”, “Colors”, “Optimization” tabs with colors to make them more 

visible. 
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5.15 Color systems menu 

5.15.1 “Natural colour system (NCS)…” 

Opens a new window where you can access the colors in the NCS system. These colors can 

be individually selected and saved as user colors. 

5.16 Help menu 

5.16.1 “ColorCalculator website” 

Opens a web browser to the home page of this program. You can check if a new version is 

available. 

5.16.2 “Check the web site for updates” 

Checks to see if a new version of the software is available. 

5.16.3 “Check for updates at start-up every 7 days” 

Checks to see if a new version of the software is available when you start the program every  

7 days. 

5.16.4 “Check for updates at start-up every 30 days” 

Checks to see if a new version of the software is available when you start the program every 

30 days. 

5.16.5 “Open pdf user guide” 

Opens a pdf version of this file if it exists in your local directory. 
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5.16.6 “View license agreement” 

Display the license agreement. 

5.16.7 “ams OSRAM website of LED spectra” 

Opens a browser to a web site with the spectra of current ams OSRAM LEDs. 

5.16.8 “About” 

Gives some very general information about this program. 
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6 Revision information 
Definitions 

Draft / Preliminary: 
The draft / preliminary status of a document indicates that the content is still under internal review and subject to change without notice. ams-OSRAM 
AG does not give any warranties as to the accuracy or completeness of information included in a draft / preliminary version of a document and shall 
have no liability for the consequences of use of such information. 

 

Changes from previous version to current revision v1-00 Page 

Initial production version  

 

● Page and figure numbers for the previous version may differ from page and figure numbers in the current revision. 

● Correction of typographical errors is not explicitly mentioned. 
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7 Legal information 
Copyright & disclaimer 

Copyright ams-OSRAM AG, Tobelbader Strasse 30, 8141 Premstaetten, Austria-Europe. Trademarks Registered. All rights reserved. The material 

herein may not be reproduced, adapted, merged, translated, stored, or used without the prior written consent of the copyright owner. 

Demo Kits, Evaluation Kits and Reference Designs are provided to recipient on an “as is” basis for demonstration and evaluation purposes only and 

are not considered to be finished end-products intended and fit for general consumer use, commercial applications and applications with special 

requirements such as but not limited to medical equipment or automotive applications. Demo Kits, Evaluation Kits and Reference Designs have not 

been tested for compliance with electromagnetic compatibility (EMC) standards and directives, unless otherwise specified. Demo Kits, Evaluation 

Kits and Reference Designs are not prepared or tested for eye safety. Unless specified otherwise, the user is solely responsible for all required safety 

measures and for complying with the applicable statutory requirements and standards. Demo Kits, Evaluation Kits and Reference Designs shall be 

used by qualified personnel only. 

ams-OSRAM AG reserves the right to change functionality and price of Demo Kits, Evaluation Kits and Reference Designs at any time and without 

notice. 

Any express or implied warranties, including, but not limited to the implied warranties of merchantability and fitness for a particular purpose are 

disclaimed. Any claims and demands and any direct, indirect, incidental, special, exemplary or consequential damages arising from the inadequacy 

of the provided Demo Kits, Evaluation Kits and Reference Designs or incurred losses of any kind (e.g. loss of use, data or profits or business 

interruption however caused) as a consequence of their use are excluded. 

ams-OSRAM AG shall not be liable to recipient or any third party for any damages, including but not limited to personal injury, property damage, loss 

of profits, loss of use, interruption of business or indirect, special, incidental or consequential damages, of any kind, in connection with or arising out 

of the furnishing, performance or use of the technical data herein. No obligation or liability to recipient or any third party shall arise or flow out of ams-

OSRAM AG rendering of technical or other services. 

Headquarters 

ams-OSRAM AG 

Tobelbader Strasse 30 

8141 Premstaetten 

Austria, Europe 

Tel: +43 (0) 3136 500 0 

Please visit our website at ams-osram.com 

For information about our products go to Products 

For technical support use our Technical Support Form 

For feedback about this document use Document Feedback 

For sales offices and branches go to Sales Offices / Branches 

For distributors and sales representatives go to Channel Partners 
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